Table of Contents

Contents
How to Create Formulas.................................................................................................................................................. 3
Naming Ranges............................................................................................................................................................. 6
Common Formula Errors............................................................................................................................................ 8
Some Useful Functions ............................................................................................................................................... 11
Data Validation.......................................................................................................................................................... 15
Turning Off Data Validation..................................................................................................................................... 17
Excel 2007 Formulas

Overview

Formulas are absolutely vital to the Excel program. As John Walkenbach says, “If it weren’t for formulas, a spreadsheet would simply be a glorified word-processing document that has great support for tabular information.”

We know that when you create charts in Excel, those charts automatically update whenever the information that is used to create them changes. Likewise, the results of formulas automatically change whenever their source information changes. This is great for performing many kinds of “what-if” analyses.

Of course, having used computers, we all know the old phrase “garbage in, garbage out”. So just having a formula doesn’t automatically guarantee that you’ll get the correct information; the formula has to do what you intend it to do.

Objectives

At the completion of the workshop, participants should be able to:

1. Create simple formulas and troubleshoot errors in formulas
2. Use named ranges
3. Use various functions in formulas, including nested functions
4. Utilize data validation in Excel worksheets

1 How to Create Formulas

We know that Excel recognizes 3 types of information: text, values, and formulas. Obviously it interprets something as text if it begins with letters and not numbers. Excel interprets an entry as a value if it’s a number or a date. And it recognizes an entry as a formula if it begins with the equals sign “=”.

So formulas must begin with an “=". After the equals sign, however, you have a lot of choices. Must formulas always contain cell references such as F13? Absolutely not. You can certainly have a formula like =12572*15. When you enter that formula into a cell and press Enter, you get the result, 188580. So Excel is acting like a calculator if you don’t happen to have a calculator handy. There’s nothing wrong with this, but you do lose a lot of utility when you use only constant values instead of cell references in formulas.

Very often, functions are used in formulas. The AutoSum function is one of the most-often used functions. The AutoSum function is simply =SUM(range), where range is a range of cells like A3:A25.
The use of functions requires parentheses before and after the “argument” of the function, and this introduces us to the topic of parentheses in formulas. If you’re not using a function, do you have to use parentheses in a formula? It depends.

When you’re using cell references in a formula, or constants, or a mix of the two, you’ll be using mathematical operators. These include:

- **Addition**: +
- **Subtraction**: -
- **Multiplication**: *
- **Division**: /
- **Exponentiation**: ^

You have to be aware of something called “operator precedence”. Operator precedence means that some operators will be performed before others.

The exponentiation operator has top precedence; it’s always performed first. Then, multiplication and division are performed. Finally, the addition and subtraction operations are performed. If you think that Excel calculates the expression 6+4/2 as 5, that’s incorrect. Excel calculates it as 8, because it performs the division first.

But you can control operator precedence by the use of parentheses. If you intended for the addition operation to be performed first, use parentheses so that the expression becomes (6+4)/2. Excel always evaluates expressions inside parentheses first.

And remember, it’s a good idea to use parentheses even if you don’t have to, because it tends to make the formula appear simpler, if it’s long and complex. If you ever need to edit a formula, whether it’s to change it or correct it, just click on the cell that contains the formula and the formula will appear in the formula bar. Once there, it’s easy to click and add or change a cell reference or parenthesis.

Using cell references in formulas is very powerful, for two reasons. First, the formula result changes as the cell contents change. But another reason is that often, you can enter the formula only once and then copy it to other cells. As you do that, the formula adjusts to the location it’s being copied to.
In this example, we only had to enter the formula for column B, and then we copied it across to column J and it adjusted. This is referred to as “relative addressing”, and it’s a very powerful concept.

There are cases, however, when you do not want relative addressing. For instance, let’s suppose you have a “grand total”, and you want to divide values by the grand total in order to arrive at a percentage. If you develop a formula that divides a value by the grand total and then copy the formula across a range, it won’t work because the cell containing the total amount changes.

In this example, our total is in cell L10. Watch what happens when we copy the formula in cell L3 to the cells below it.
Excel is displaying the infamous “divide by zero” error, because the cell reference for our divisor changed as the formula was copied.

Note that when we move our cursor over the “!” error indicator, Excel displays a helpful message, telling us what it thinks the problem is. This sort of problem can be corrected easily but happens quite often. It’s fixed by making the divisor in your formula an absolute reference, so that it doesn’t change if it’s copied across a range of cells. To do this, you simply change the cell reference of L10 in your formula to $LS10. When we do that, here’s the result:

2 Naming Ranges

In Excel, you can assign a name to a cell or range of cells. This comes in very handy with formulas, because you can have a formula like

=quantity*price*sales_tax

instead of
To assign a name to a cell (or range), you simply select the cell, then type its name in the Excel name box.

We’re all used to the name box displaying the name of the selected cell, but it can also be used to create cell or range names, not just display them. If you have several named cells or ranges in your spreadsheet, clicking the drop-down in the name box will display all of them.

There are a couple of rules for creating names in Excel. First, the names can’t contain any spaces, so use an underscore character to separate two or more words. Also the name must begin with a letter, not a number. The exception to this is, if you need to have a name like 3QTR, for example, you can begin the name with an underscore, as _3QTR.

Now, let’s see how using names helps us avoid the problem we had earlier with relative and absolute addressing. If we name cell L10 grand_total, we then change our formula to =J3/grand_total in the formula bar.

Now, when we copy the formula to the range L4:L8, watch what happens:
It remembers that the divisor is in cell L10, and you don’t need to worry about absolute or relative addressing! This is a big advantage to using names, in addition to making your formulas easier to look at and understand.

We use a utility in Excel called the Name Manager to delete or modify existing named ranges. You can also use it to create new named ranges, although the name box is easier. The Name Manager is invoked by clicking on the Formulas tab, then clicking on the Name Manager button in the Defined Names group.

3 Common Formula Errors

As we saw earlier, perhaps the most common formula error in Excel is division by zero, or #DIV/0!, which is how it’s indicated in your spreadsheet. When you get this particular error, or any error, Excel offers to help you solve it by displaying the “!” inside a diamond-shaped area. If you move your cursor over the diamond, you’ll get a basic explanation of the error message.
If you click the drop-down next to the diamond, other options will appear:

```
 #DIV/0!
```

The formula or function used is dividing by zero or empty cells.

If you click the drop-down next to the diamond, other options will appear:

```
 #DIV/0!
```

“help on this error” will open up a help window, and “show calculation steps” will offer to step you through the steps that will cause an error to happen.

Another common error with formulas is #NAME?, which occurs when you use a name in a formula that Excel doesn’t recognize. We’d get this error if we used the formula `=J3/grand_totall`, for example. We misspelled “grand_total”. Unfortunately, Excel doesn’t offer to help us by showing names in the spreadsheet that may be similar. If you’re working with a spreadsheet that you’re not too familiar with, the best option may be to go the Name Manager.
utility and make sure what the existing names are. It may be that the original name for the range was spelled incorrectly! If that’s the case, Name Manager will allow you to edit the name.

If you’re attempting to use a function and you don’t enter the arguments for the function that Excel is expecting, you’ll get an error message like this:

The message is referring to this button in the formula bar:

However, notice Excel is giving you help on the appropriate syntax for the function below the formula bar also. But if you click on the Insert Function button you get a lot of help on the function:
4 Some Useful Functions

Excel has a huge number of built-in functions; over 300 at last count. Some of them you’ll never use, some you’ll use very frequently. If you’re interested, you can always examine the list by clicking on the Insert Function button to the left of the Formula Bar, choose Category: All, and just scroll down. Note that when you single-click on each function name, you get a short description of what the function does and what its arguments should be.

Math functions

Obviously, to sum a range of cells, just use sum(range). But what if you want to sum only certain values in the range, like those whose value is greater (or less) than a certain amount? Then you use sumif(range, criteria). In our spreadsheet example, we want to sum the range of B3:J3, but only those values that are greater than 90,000. So our formula looks like: =sumif(b3:j3, “>90000”). You always use quotation marks around criteria.

Sumifs is used the same way as sumif, but it can handle multiple criteria. Likewise, there’s a function that calculates the average of a range, and it’s just average(range). And just like sum, there is averageif(range, criteria) and averageifs(range, criteria1,criteria2,…).

Be sure not to forget about the autocalculate indicator on the status bar, also. Remember that if you select a range of cells, it will show you the average, the count, the minimum, maximum, and sum without using any formulas or functions at all.
Counting functions

There are a number of counting functions that are useful. Count(range) gives you the number of cells in a range that contain a “value”. Remember, Excel considers both dates and numbers to be values. Counta(range) tells you the number of cells in a range that aren’t empty. So if we used =counta(a3:a10), the result should be 7, and it is.

Conversely, countblank(range) gives us the number of cells that are empty. So countblank(a3:a10) should return a value of 1, and it does.

Countif(range, criteria) generates the number of cells in a range that meet a certain criteria. This is currently being used by some faculty on campus to determine the number of absences for students in a spreadsheet where class attendance is maintained. The text that they use is “a” for absent. Notice that the criteria is not case-sensitive. If you’re using countif, always try to avoid having the asterisk symbol (*) in your spreadsheet cells. The asterisk symbol is the “ wildcard” character, and it sometimes produces unpredictable results. Countifs is just like countif, except you can use multiple criteria.

Date functions
Excel has a couple of built-in date functions that don’t require an argument: today() and now(). The difference is that typing =today() returns today’s date, whereas entering =now() gives you the date and time.

A very useful function among date functions is yearfrac, which returns the number of years between two dates as a fractional value. It’s used as: yearfrac(start_date,end_date). Now if someone’s birthdate is in cell B14 and I want to calculate that person’s age, I can use:

=yearfrac(b14,today())

However, the result is a fraction. If I want it to be a whole number, I have to use the int function which rounds a number down to the nearest integer. So the complete function would be:

=int(yearfrac(b14,today()))

Logical functions

The classic logical function, and probably the one most used, is simply the IF function. It’s used in the following way:

If(test_for_condition, perform_if_condition_is_true, perform_if_condition_is_false)

A classic example is computing sales commissions for your company’s salespersons. If their total sales are greater than $100,000 they get a commission of 5 percent, otherwise they get a commission of 3 percent. So the formula would read:

=if(sales > 100000,sales * .05,sales * .03)

Here’s another example: let’s say we have column totals for a group of columns in row 10. First we select that range of totals and name it “total”. Below the totals, in row 12, we have the following formula:

=if(total>450000,”yay”, ”boo”)

What does this do? In the cells where this formula appears, if the referenced total is greater than 450000, then “yay” is displayed. If not, then “boo” is displayed. See below:
This is fine when we have just two conditions: total is either greater than 450,000 or it’s not. But suppose we have three conditions: we want to display some information when the cell is less than 450,000 and we want to display something else when it’s greater than 450,000 but if it’s more than 480,000 we want to display a third value. This is where nested if functions come in.

Basically, a nested function is just inserting a function inside another function so that the nested function becomes one of the operations that the original function performs as a result of the condition test. Recall

If(test_for_condition, perform_if_condition_is_true, perform_if_condition_is_false)

Using nested functions, it becomes:

IF(test_for_condition,perform_if_condition_is_true, IF(test_for_condition, perform_if_condition_is_true, perform_if_condition_is_false))

Here’s an example where we’ll nest a second IF function to be performed if the condition is false. We want the cell to display “boo” if total is less than 450,000. We want it to display “hooray” if total is greater than 480,000 and “good” if total is between 450,000 and 480,000. So the formula looks like this:

=IF(total < 450000, ”boo”, IF(total > 480000, “hooray”, “good”))

The nested IF is performed if total is greater than 450,000. In the nested function, if total is greater than 480,000 the first operation is performed (“hooray” is displayed). If total isn’t greater than 480,000 then it must be between 450,000 and 480,000 and the second operation is performed (“good” is displayed).
Other functions

Excel also has a number of functions that deal with text only. The function proper(range) converts a text string to proper case, where the first character is uppercase and the others are lowercase. Likewise, lower(range) converts all characters to lowercase and upper(range) converts all characters to uppercase.

Note that the proper function can be useful if you’re using a range of names in a spreadsheet as input for a mailing list.

5 Data Validation

There may be an occasion when you need to create a spreadsheet that other people will be entering data into. If it’s important that the data be correct, you may want to use Excel’s data validation utility. To use it, just select the cell that data will be entered into. Then click the Data tab, then Data Validation in the Data Tools group.
When you click the Data Validation button, then click on the drop-down beside “Allow any value”.

If you select “Whole number”, you’ll be given a lot of choices including range, equal to, greater than, etc. I want a value entered that’s between 10 and 20, and I don’t want the cell to be blank, so I’ve filled out the dialog like this:

Now, I want to customize the error message that’s displayed if an incorrect value is entered, so I click on the Error Alert tab, and type in an error message.
This is a very handy little utility, but we need to be aware that the data validation utility can be defeated if someone copies and pastes information to the cell rather than entering the data. However, it is easy to use and you might find it quite helpful in certain situations.

### 6 Turning Off Data Validation

You need to know how to “get rid” of data validation as well, because if you’ve decided to use it in a worksheet it’s not obvious which cells are controlled by validation. First, on the Home tab, in the Editing group, click Find & Select, then click Data Validation.
This will highlight the cells that have data validation turned on. Now you have the option of turning off data validation for all the cells (if you have it turned on for more than one cell), or just one cell.

Let’s say that I have data validation for 3 cells: A1, C3, and E1. Each cell has a different validation criteria. If I want to erase validation for E1, I select it, change the validation criteria to “allow any value”, then click OK.

If you have more than one cell with the same criteria, click “Apply these changes to all other cells with the same settings”, and all the cells that have the same criteria with be cleared.

On the other hand, if you want all data validation cleared whether it’s the same criteria or not, with all validation cells selected, click Data Validation on the Data tab, then click OK in the dialog below.

Then OK in the next window.
Data Validation

Validation criteria

Allow:
- Any value
- Ignore blank

Data:
- between

Apply these changes to all other cells with the same settings

Clear All  OK  Cancel